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GOLD Overview

The revamped GOLD database GOLD v.9 is based on a four-level project
classification system. These are Studies, Biosamples/Organisms, Sequencing
Projects (SPs) and Analysis Projects (APs).

[ Study ]

Organism
(Cultured isolate organisms or uncultured
single-cells)

Biosample
(DNA/RNA samples collected from their
environment)

Sequencing Projects Sequencing Projects
1. Metagenome 1. lIsolate Whole Genome Sequence
2. Metagenome - Cell Enrichment 2. Isolate Transcriptome
3. Metagenome - Single Particle Sort 3. Single-cell Whole Genome Sequence
4. Metatranscriptome 4. Others
Analysis Projects Analysis Projects Analysis Projects
Combined Assembly 1. Isolate Genome
. Metagenome .
. Metagenome - Cell Enrichment - Metagenome s Tlranscrlptome
. Metagenome - Single Particle Sort - Single-cell BB S!ngle-cell SEEEmE
. Metagenome-Assembled Genome - Metagenome & Single-cell Ei, il ehEeEame
. Metatranscriptome 4. Other AP types

. Metatranscriptome
. WGS Projects from same Organism

Study is an umbrella project that broadly defines the overall goal of a research
proposal and outlines the key objective of its underlying projects. It contains a list
of sequencing projects that are a part of the original proposal. ‘Proposal’ is a
synonym for ‘Study’ (e.g., HMP study, GEBA study, etc.).

Biosample is a description of the environment from where a DNA/RNA sample
was collected. A Biosample contains metadata such as a habitat, an ecosystem,
a geographical location, a latitude/longitude, etc. Defining a Biosample entity is
essential for creating a GOLD Sequencing Project with Metagenome and
Metatranscriptome sequencing strategy. DNA and RNA extracted from the
same physical sample can be used for a metagenome and a metatranscriptome
project, respectively.

Organism is a description of an individual entity such as a bacterium, a fungus, a
plant, an animal, or a virus. It can be a cultured isolate of a pure strain of a
bacterium or an uncultured single cell (e.g., isolated by using cell sorting). It can
also be an uncultured non-living organism such as a Metagenome-Assembled
Genome (MAG). All Organisms in GOLD are required to have basic taxonomic
information such as a phylum, a genus, a species, a strain, and an NCBI taxonomy
ID. Defining an Organism entity is essential for creating GOLD Sequencing



Projects with Whole Genome Sequencing (WGS) and Transcriptome sequencing
strategies.

Sequencing Project is a description of the sequencing output from an individual
Organism or Biosample. An individual Sequencing Project may be composed of
more than one sequencing reaction and/or sequencing technology. A Sequencing
Project may be for an isolate genome, a single cell, a metagenome, a
metatranscriptome, etc.

Analysis Project is a description of the informatics processing of a sequence
associated with a corresponding Sequencing Project. It specifies how the
assembly and annotation of the sequence were performed. Defining an AP entity
is essential for submitting dataset to IMG for analysis. An individual submission in
IMG represents an individual Analysis Project in GOLD.

Please refer to our publication titled “Twenty-five years of Genomes OnLine
Database (GOLD): data updates and new features in v.9” in the Nucleic Acids
Research annual Database Issue for more details about this four-level
organization.

How to start with entering a new project into GOLD

From the GOLD home page, click the “Register” button to go to the landing page
for entering a Sequencing and/or Analysis Project.

JGIHOME LOGIN

ABASE
Biogeographical Metadata  Ecosystem Classification SRA Explorer  Statistics® Usage Policy Team Help News Downloads GOLD API

Welcome to the Genomes OnLine Database GOLD Release v.9
GOLD: Genomes Online Database, is a World Wide Web resource for comprehensive access to information regarding genome and
metagenome sequencing projects, and their associated metadata, around the world.

1. Register 2. Annotate
GELD E-
—)
Register your project information and Annotate your microbial genome or
Metadata in the Genomes Online Database metagenome with IMG

b

Create Sequencing Project or Analysis Project

» Create Sequencing Project in GOLD

» Create AP for Submission to IMG/MycoCosm/PhycoCosm
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If your Sequencing Project is not yet in GOLD, you will start by clicking the “Create
Sequencing Project in GOLD” tab to define a new Sequencing Project.

Create Sequencing Project in GOLD

If you performed additional sequencing (either with a new seq. technology
or at a new seq. center) to your current project add the new information to
the corresponding field(s) of the existing project in GOLD and create a new
Analysis Project for it.

If submitting a newer assembly (for an existing project in GOLD) to IMG,
just create a new Analysis Project.

Is this a public NCBI genome/metagenome?
Yes O
No @

GOLD does not accept manually entered public NCBI genomes/metagenomes.
If you want to analyze a public genome/metagenome, follow detailed instructions
available here: Guidance on submitting public NCBI genomes and metagenomes
into GOLD and IMG. Otherwise, select the radio button ‘No’ to move on to the next
step.

1) Entering a Genome (Isolate) Sequencing Project (SP) and an
associated Analysis Project (AP).

Step 1: Study > Step 2: Select Project Type > Step 3: Organism
(Cultured/Isolate) > Step 4: Sequencing Project > Step 5: Analysis Project

The first step to create a Sequencing Project is to define your Study. After
confirming that you are NOT entering a public NCBI genome/metagenome, you
will come to the page (see the screen below) where you will be able either to select
an existing study, under which you want to carry out this new sequencing project,
or to define a new study. When applicable, choose a matching study from the drop-
down menu.

1: Select/Create Study

—_—

Step 1: Select/Create Study

[select a Study v

OR
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Entering a new Study:

If your new sequencing project is pursued under a new study, click the “Create
Study” button to go to the Study entry form. Fill in at least all required fields (*) as
shown in the screenshot below. If there is an NCBI BioProject comprising multiple
other BioProjects, enter its Name, ID, and Accession into the corresponding NCBI
Umbrella BioProject fields. For example, PRINA28331 is an Umbrella BioProject
for Human Microbiome Project (HMP), and it contains about 3000 of the individual
BioProjects. If you do not have an umbrella BioProject, leave these fields blank.
Do not enter NCBI BioProject IDs or Accessions for individual BioProjects here at
the Study level.

Step 1: Add or create a new study

1. a) Select a study from your existing studies:
[Select a study v

OR

1. b) Click the button to create a new Study:

[ Add a new Study to GOLD ]

Please fill in the form below to create a new Study.

STUDY INFORMATION

Study Name * Test study to compare Escherichia coli strains

Other Names

NCBI Umbrella Bioproject Name

Pl Name Supratim Mukherjee

Pl Email XXXXXXX@Ibl.gov

Description * This is a test study for MGM

[
[
[
NCBI Umbrella Bioproject Accession [
[
[
[
Relevance [

Comparative analysis

Add Relevance

ECOSYSTEM CLASSIFICATION
Ecosystem * [ Host-associated Vl
Ecosystem Category * [ Mammals: Human Vl
Ecosystem Type [ Digestive system Vl
Ecosystem Subtype [Large intestine v]
Specific Ecosystem [ Fecal vl

Create New Study

Click the ‘Create New Study’ button and proceed to the next step, i.e., selecting
what kind of project you are about to create.



Selecting Project Type:

Create Sequencing Project

1: Select/Create Study 2: Select Project Type

o @

Step 1: Selected/Created Study - Test study to compare Escherichia coli strains
Step 2: Select Project Type

Before proceeding:
* Review the Project Entry Help document.

« To avoid delay in processing your metagenomes/metatranscriptomes, read the Standardized Metagenome Naming,
document. (PubMed ID: 36794865)

« Contact us with any questions, or if submitting more than 10 projects.

Select Sequencing Project type to create:
Biome O
Organism @

Select the radio button ‘Organism’ since you are creating an Isolate genome
sequencing project. To create an isolate genome sequencing project, you need
either to select an existing Organism or to define a new Organism. Start by
searching for a specific Organism strain in GOLD. Once you start typing any part
of the Organism name (preferably, a strain or a culture collection id, e.g., DSM
1234 or ATCC 4567), you will get a list of the matching organisms to choose from.
Select the exact strain if it is available.

Create Sequencing Project

1: Select/Create Study 2: Select Project Type 3: Select/Create Organism

Y G @

Step 1: Selected/Created Study - Test study to compare Escherichia coli strains
Step 2: Selected Project Type - Organism

Step 3: Select/Create Organism

Search for existing Organism by entering genus, species or strain:

Escherichia coli UTI
Go0000370 - Escherichia coli UTI89 (UPEC)

OR

Create Organism

If the exact strain of the organism you are sequencing is not available or you have
a new isolate, click the “Create Organism” button to proceed to enter a new
Organism. In the next page, you have to indicate whether your organism is cultured
or uncultured, and whether it was sequenced by you/your lab/your colleague or it
was obtained from a culture collection (ATCC, DSM, etc.)



Step 1: Selected/Created Study - Test study to compare Escherichia coli strains
Step 2: Selected Project Type - Organism

Step 3: Select/Create Organism

Search for existing Organism by entering genus, species or strain:

OR

Create Organism

Select the type of Organism:
Cultured @
Uncultured O

@ lIsolated by me/colleague
(O Obtained from a culture collection
Select a package:

@® standard

O Host-Associated Package
O Hydrocarbon Core Package
O Hydrocarbon FS Package
O Microbial Mat Package

O Plant Package

O sediment Package

O Ssoil Package

O Water Package

If the Organism is isolated from a host-associated, soil, aquatic or any other
environment listed above, you have an option to select the appropriate package
and get access to the form with additional metadata fields specific to the respective
environment. Otherwise, choose the Standard package to access the default
Organism entry form.

Enter organism-specific information such as the organism’s name, genus, species,
strain, NCBI taxonomy id, culture collection id, etc. into the form. Please note that
for the Species field, we require to use the binomial nomenclature (two-term
organism naming system) as per the nomenclature conventions followed by NCBI
taxonomy. For example, enter “Escherichia coli’ into the Species field as shown in
the example below. If only a genus is defined for your organism, use a format
“Genus sp. Strain’, e.g., “Pseudomonas sp. 12ab” to populate the field Species.
Fill in the rest of the form.

Though not all fields are mandatory, we encourage you to enter all available
metadata.



1: Select/Create Study 2: Select Project Type 3: Select/Create Organism 4: Create Sequencing Project

G o @ o

» Step 1: Selected/Created Study - Test study to compare Escherichia coli strains

» Step 2: Selected Project Type - Organism

~ Step 3: Select/Create Organism - Cultured -> Isolated by me/colleague -> Standard package ‘

Fill in the form with Organism’s metadata

Organism Name 0. lEscherichia coli test123 I
Other Names [ l
Genus ' * IEscherichi l
Species O * IEscherichia coli I
SEn® [test123 |
(Not applicaple for phylum PLANTS-STREPTOPHYTA)

Subspecies [ l
Taxonomy Classification Method 0. I 16S and ANI I
Serovar/Cultivar I I
e 'PSEUDOMONADOTA vl
NCBI Taxonomy ID * ' 562 |NCBI Taxonomy
NCBI Taxonomy Name Escherichia coli

Type Strain

[Select from below... /|

Culture Collection ID I

Organism Type * I Natural v l
Cultured/Uncultured Cultured
Culture Type * |Isolate Vl

Biosafety Level

a )




Cell Shape

Color

Gram Stain

Motility

Oxygen Requirement (MIGS-22)

pH

Salinity (MIGS-6.3)

Pressure

Sporulation

Carbon Source i)
Growth Temperature
Cell Arrangements
Diseases (MIGS-15)
Habitats (MIGS-6)
Metabolism
Phenotypes

Energy Sources
Body Products

Biotic Relationships (MIGS-14)

Propagation i

|Rod-shaped v|
[Cream v|
[Gram- v
[Motile v|

[Facultative anaerobe V|

(45 |0 [0 || Add pH Range

|Undefined v|

l l

[Nonsporulating  v|

I Glucose, Lactose ]

|20 ICeIsius. to [50 ]Celsius.
| Add Growth Temperature Range ]

[Singles v|

|Gastroenteritis v|

I Human gastrointestinal tract v ]

[Hydrocarbon degrading v|

[Fast growing v

[Heterotroph v|

[Feces M

[Free living v|

l l

Sample Collection Date *

Sample Collection Site i

Isolation Country/Ocean *

T o (3

Collection Method o
Contact Name (i

Contact Email 0.

Month (mm) * : Day (dd): Year (yyyy) * :

l Human feces ]

[usA v|

I

| serial dilution

ISupratim Mukherjee

l XXXXXXXXXX@Ibl.gov




Ecosystem *
Ecosystem Category *
Ecosystem Type *
Ecosystem Subtype

Specific Ecosystem

Geographic Location 0.
Lat/Long Lookup

Latitude ' *

Longitude Li

LatLong Information 0.
Elevation
Depth

Subsurface Depth

Temperature Range

[~

P! P

Salinity Concentration

Host-associated V|

Mammals: Human M
Large intestine v
Fecal v|

[
[
| Digestive system v
[
[
[

USA: Walnut Creek |

[37.9021 |
[-122.0619 || Reset Map |
i Reno
=+ Chico par
Y
_— Car.son
Sacramento S,
04K dStockton
NN
N\ 539}3“9 California
> Fresno
‘ISaIAOnas ot
\ Visalia
Leaflet | Map data © OpenStreetMap contributors, CC-BY-SA, Imagery ©
OpenStreetMap
[Verified v

Meters. to Meters.[ Add Elevation Range ]

L]
[ |meters. to | |Meters.| Add Depth Range |
Meters. to Meters.

[ Add Subsurface Depth Range ]

[Mesophile v|

37 Celsius. to Celsius.

[ Add Sample Collection Temperature Range ]

Isolation Host Name ' *

Host Taxonomy ID 0.

Host Gender

Host Race
Host Age

Host Health Condition

Health Disease Status
Host Medication

Host Body Site
Host Body Subsite
Host Body Product

Host Specificity or Range

Host Comments

[ Homo sapiens ]

[55 years ]

[Healthy v|

[ None ]

(Gastrointestinal v

[Gut v]

[Feces v

l ]
l ]

[ Create New Organism J

Once you select an existing Organism or have defined a new Organism, you can
proceed to the next step, i.e., creating a new Sequencing Project.
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Entering a Sequencing Project:
To define a new Sequencing Project, populate at least all required fields (*) such

as Sequencing Center,

Project Description,

Sequencing Strategy Type,

Sequencing Technology, etc. as shown in the screenshot below. Enter NCBI

BioProject and Biosample Accessions ONLY if they are not public in NCBI.

PROJECT INFORMATION

Project Name *

Other Names

NCBI BioProject Name
NCBI BioProject Accession
NCBI Locus Tag

NCBI BioSample Accession

Pl Name
Pl Email
Project Comments

Sequencing Center *

Collaborating Institute

Funding Agency

Project Description *
PROJECT TYPE

Specimen

Nucleic Acid *

Sequencing Strategy Type *
Sequencing Strategy Subtype
SEQUENCING INFORMATION
Sequencing Status *
Sequencing Quality (MIGS-31) *
Finishing Goal

Contamination Screening Input
DNA Amplification Method
Single Cell Lysis Protocol
Single Cell Lysis Approach
Sequencing Comments

DNA Amplification Kit

Library Method

Library Layout

Library Screening Method
Number Of Reads

Read Size

Vector

GC Percent
Chromosome Count

Plasmid Count

Sequencing Technology (MIGS-29) *

| Escherichia coli test123

|PRINA12345

| SAMN543210

[Supratim Mukherjee

[ xxxxx@Ibl.gov

University of California, Berkeley

DOE Joint Genome Institute (JGI)

Sequencing of an E. coli strain from human feces

|DNA v

|Whole Genome Sequencing V|

[Complete M
[Level 2: High-Quality Draft M
|Select from below... M

[Select from below... V|

[Select from below... V}

I

|Select from below... V|

[lllumina HiSeq 2500 v

I

[Select from below... V|

| _Create New Seatiencina Proiect |

11



Once you enter all relevant information, click the “Create New Sequencing Project”
button.

Now you can proceed to create a GOLD Analysis Project, or you can leave and
come back later (when you are ready to submit data to IMG) to create a GOLD AP.

Entering a Genome Analysis Project for an isolate genome:
Go to the main project submission page and click the “Create Analysis Project for

Submission to IMG/MycoCosm/PhycoCosm” button. Select “Genome Analysis
(Isolate) Project” from the drop-down menu and proceed.

L Create Sequencing Project or Analysis Froject —

» Create Sequencing Project in GOLD

Create AP for Submission to IMG/MycoCosm/PhycoCosm
Before proceeding:

o IMG only accepts FASTA (not Genbank formatted) files for analysis. See IMG FAQ.
« Metagenome-Assembled Genome (MAG) AP creation is no longer available. As an alternative... [more]

e There are two AP submission types: Primary and Re-analysis. [more]

« Your first two APs under each AP type needs to be approved before you can submit additional APs.

Select AP type...

Vv Genome Analysis (Isolate) Project
Metagenome Analysis Project
Metagenome - Cell Enrichment Project
Metagenome - Single Particle Sort Project

Metatranscriptome Analysis Project

Single Cell Analysis (screened) Project

Single Cell Analysis (unscreened) Project
Combined Assembly Project
Metagenome - SIP Project

You can create a Genome Analysis Project for your own Sequencing Project that
you have previously created, or you can create a Genome AP for any public
sequencing project if you have reassembled the associated public sequences and
want to re-annotate them.

To create an Analysis Project for your own Sequencing Project, select the

corresponding SP from the drop-down menu and go to the Analysis Project
creation page.

12



Select Parent Project

You are creating a new Genome Analysis (Isolate) Project

Select one of your existing Sequencing Projects:

(Gp0704593 - Escherichia coli test123 V]

OR

Search for a Public Sequencing Project (you will be asked to assign a study on the next
screen):

Note: If you still need to create a new sequencing project for your submission please click below to
create a new sequencing project.

Fill in at least the required fields as shown below. If appropriate, provide a suffix to
AP name: a version number, a draft number, etc. anything that will allow you to
distinguish between versions in case you have re-sequenced the same organism
or reassembled the same sequence. Click the “Submit” button to finish.

Create Analysis Project

You are creating a new Genome Analysis (Isolate) Project

Please fill in the form below to create a new Analysis Project.
The Sequencing Project for this AP is: Escherichia coli test123
Analysis Project Type: Genome Analysis (Isolate)

Escherichia coli test123

Analysis Project Name o N
Suffix: [ First draft ]

Study Test study to compare Escherichia coli strains

Analysis Project Description * [Assembly and annotation of first draft l
Analysis System * IMG v

PI Name [Supratim Mukherjee l
Pl Email [xooooxx@lbl.gov |

Assembly Method * i] [Velvet v.2.3

Scaffold Count |2

l
l
Contig Count ' ( ]
l
l

Estimated Size l 4072660
Sequencing Depth o [50)(

Genbank ID [ l

Assembly Accession l l

Once you successfully create an Analysis Project, you will see the following
window:

13



Processing Complete —

GOLD AP Ga0618790 created.

To submit your data set to IMG, you will need this Analysis Project ID: Ga0618790

Submit your data to IMG now.

Or start another Analysis Project.

Click the link to proceed to IMG for data submission. In the future, you can create
additional APs on the same Sequencing Project if, for example, you have a new
assembly or an additional sequence to include.

If you are not ready to submit your data to IMG yet, you can return later and use
your AP for IMG submission. When you click the “Annotate” button on the GOLD
home page, you will be redirected to the IMG submission page.

JGIHOME LOGIN

TABASE
Biogeographical Metadata  Ecosystem Classification SRA Explorer  Statistics® Usage Policy Team Help News Downloads GOLD API

Welcome to the Genomes OnLine Database GOLD Release v.9
GOLD: Genomes Online Database, is a World Wide Web resource for comprehensive access to information regarding genome and
metagenome sequencing projects, and their associated metadata, around the world.

1. Register 2. Annotate
GE8LD =
]
Register your project information and Annotate your microbial genome or
Metadata in the Genomes Online Database metagenome with IMG
( megiser |

To create an AP for a public project, use the corresponding search box to select a
project of your interest by typing a part of the organism’s name or a strain and
proceed to the Analysis Project creation page.

14



Select Parent Project

You are creating a new Genome Analysis (Isolate) Project

Select one of your existing Sequencing Projects:

[Select a sequencing project... v|

OR

Search for a Public Sequencing Project (you will be asked to assign a study on the next
screen):

| GP0156133 - Escherichia coli MGM23 _test x| |

Next Step >>

Note: If you still need to create a new sequencing project for your submission please click below
to create a new sequencing project.

[Md New Sequencing Pm]ect]

Fill in at lease the required Analysis Project form’s fields as shown below. When
you are creating an AP on a public SP, you must choose the appropriate study for
your AP in case you have more than one study in GOLD. You also have the option
of creating a new Study at this point. Click the “Submit” button to finish.

Create Analysis Project

You are creating a new Genome Analysis (Isolate) Project

Please fill in the form below to create a new Analysis Project.
The Sequencing Project for this AP is: Escherichia coli MGM23_test

Analysis Project Type: Genome Analysis (Isolate)

Escherichia coli MGM23_test
Suffix: iﬁrst draft l

Analysis Project Name o

Study * | Comparative analysis of two human pathogenic bacteria (Gs0118715)
Add New Study

Analysis Project Description * ’Analysis of public sequencing project Escherichia coll

Analysis System * IMG v

Pl Name ’Supratim Mukherjee l

PI Email

lxxxxxxxx@lbl.gov I

Assembly Method * |Velvet v. 2.3

Scaffold Count ' ’2

Estimated Size |474297o

I
I
Contig Count e l I
I
I

Sequencing Depth o ’ 50x

Genbank ID

Assembly Accession

15



2) Entering a Single Cell Sequencing Project (SP) and an
associated Analysis Project (AP).

Step 1: Study > Step 2: Select Project Type > Step 3: Organism
(Uncultured/Single Cell) > Step 4: Sequencing Project > Step 5: Analysis
Project

Creating a Study and Selecting Project Type:

The first two steps for entering a Single Cell project, namely, selecting or entering
a Study and selecting an SP type are identical to the ones that were described
earlier on pages 3-6 of this document.

Entering a new Organism:

It is very unlikely that you will find a single cell organism entry already in GOLD to
choose, as no one else can possibly possess the same single cell you isolated
from an environment. The only time you may be able to use the same/existing
organism entry is if you happen to enter this organism before. In all other cases,
you will be creating a new organism for a single cell.

Entering a single cell organism is similar to entering an isolate organism, which is
described above. The main difference is in defining an organism as a single cell.
When defining an organism for single cell projects you will select the “Uncultured”
radio button as shown below. If the Organism is isolated from a host-associated,
a soil, an aquatic or any other environment listed below, you have an option to
select the appropriate package and to get access to the form with additional
metadata fields specific to the respective environment. Otherwise, choose the
Standard package to access the default Organism entry form.

16



S P ——

1: Select/Create Study 2: Select Project Type 3: Select/Create Organism

O o @

» Step 1: Selected/Created Study - Reddy's test study for help doc examples
» Step 2: Selected Project Type - Organism

Step 3: Select/Create Organism

Search for existing Organism by entering genus, species or strain:

OR

Create Organism

Select the type of Organism:
Cultured O
Uncultured

Select a package:

@® standard

O Host-Associated Package
O Hydrocarbon Core Package
O Hydrocarbon FS Package
O Microbial Mat Package

O Plant Package

O sediment Package

O soil Package

O water Package

After that, you will proceed to enter a new single cell organism. The first section of
the Organism entry form is shown below. The form is similar to the isolate
Organism form. The only difference is that the Cultured/Uncultured field is set to
the Uncultured one by default, and you need to select ‘Single Cell’ from the
Uncultured Type field’s menu.

17



Create Sequencing Project

1: Select/Create Study 2: Select Project Type 3: Select/Create Organism

O 5 L

Step 1: Selected/Created Study - Reddy's test study for help doc examples
Step 2: Selected Project Type - Organism
Step 3: Select/Create Organism - Uncultured -> Standard package

Fill in the form with Organism’s metadata

ORGANISM INFORMATION

Organism Name ' * [Ga.,,.,,.w, ia bacterium 123 l
Other Names [ ‘
Genus I ‘
Species - * [Gammaproteobacteria bacterium 123 \
Strain * ‘ ‘
(Not applicaple for phylum PLANTS-STREPTOPHYTA)

Subspecies I ‘
Phylogenetic Markers Multi-marker Approach v

Taxonomy Classification Method ‘ ‘
Serovar/Cultivar l l
Phylum *

g PSEUDOMONADOTA Vl
NCBI Taxonomy ID * |1236 ‘NCBl
NCBI Taxonomy Name Gammaproteobacteria
Type Strain No o
Culture Collection ID l
Organism Type * Natural ~|
Cultured/Uncultured Uncultured
Uncultured Type * Single Cell v

Biosafety Level
Y Select from below... /|

Once you define an organism, you will proceed to the next step, i.e., creating a
Sequencing Project.

Entering a Sequencing Project:

The process of entering a Sequencing Project for a single cell organism is identical
to the one described on pages 10-11 for an isolate organism.

Now you can proceed to create a GOLD Analysis Project, or you can leave and
come back later (when you are ready to submit data to IMG) to create a GOLD AP.

Entering a Single Cell Analysis Project:

There are two types of APs for a single-cell-based SP. They are Single Cell
Analysis Project (unscreened) and Single Cell Analysis Project (screened).

Typically, a Single Cell Analysis (unscreened) AP is used when no additional
screening is done besides the standard contamination screen.

18



Single Cell Analysis (screened) is used when an extensive manual or automatic
screening is performed to remove the sequence that does not belong to the single
cell of your interest.

Creating a Single Cell Analysis (unscreened) Project:
Go to the main project submission page and click the “Create Analysis Project for

Submission to IMG/MycoCosm/PhycoCosm” button. Select “Single Cell Analysis
(unscreened) Project” from the drop-down menu and proceed to the next step.

Create Sequencing Project or Analysis Project

Create Sequencing Project in GOLD

Create AP for Submission to IMG/MycoCosm/PhycoCosm

Before proceeding:
o IMG only accepts FASTA (not Genbank formatted) files for analysis. See IMG FAQ.

o Metagenome-Assembled Genome (MAG) AP creation is no longer available. As an
alternative... [more]

e There are two AP submission types: Primary and Re-analysis. [more]
e Your first two APs under each AP type needs to be approved before you can submit
additional APs.

Select Analysis Project type to create:

(Single Cell Analysis (unscreened) Project V|

| NextStep >> |

Choose the corresponding single cell SP from the drop-down menu.
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Select Parent Project

You are creating a new Single Cell Analysis (unscreened) Project

Select one of your existing Sequencing Projects:
|Gp0514864 - Gammaproteobacteria bacterium 123  v|

[ Next Step >> ]

Note: If you still need to create a new sequencing project for your submission
please click below to create a new sequencing project.

[Md New Sequencing Pmiect]

Fill in and submit the following form to create a Single Cell (unscreened) AP.

Create Analysis Project
You are creating a new Single Cell Analysis (unscreened) Project
Please fill in the form below to create a new Analysis Project.

The Sequencing Project for this AP is: Gammaproteobacteria bacterium 123

Analysis Project Type: Single Cell Analysis (unscreened)

Analysis Project Name (i) Gammaproteobacteria bacterium 123

Suffix: I l
Study Test study for help doc examples
Analysis Project Description * ‘Assembly and annotation of first draft ]
Analysis System * IMG v

]
PI Name [Supratim Mukherjee |
|

Pl Email supramuk@gmail.com l

Assembly Method * i

Number of tRNAs '

tRNA Software '

Completeness Strategy Reference Based V|

Contig Count 0

Estimated Size

\
1
I
J
Scaffold Count " 14
l
1
I

Sequencing Depth o

Genbank ID I |

Assembly Accession | l
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Once an AP is created, you will see the following window:

| Processing Complete —

GOLD AP Ga0618791 created.

To submit your data set to IMG, you will need this Analysis Project ID: Ga0618791

Submit your data to IMG now.

Or start another Analysis Project.

Click the link to proceed to IMG for data submission.

If you are not ready to submit your data to IMG yet, you can return later and use
your AP for IMG submission. You will be redirected to the IMG submission page
when you click the “Annotate” button on the GOLD home page.

JGIHOME LOGIN
TABASE

Biogeographical Metadata  Ecosystem Classification  SRA Explorer  Statistics  Usage Policy Team Help® News Downloads  GOLD API

Welcome to the Genomes OnLine Database GOLD Release v.9
GOLD: Genomes Online Database, is a World Wide Web resource for comprehensive access to information regarding genome and
metagenome sequencing projects, and their associated metadata, around the world.

1. Register 2. Annotate
GELD -
—
Register your project information and Annotate your microbial genome or
Metadata in the Genomes Online Database metagenome with IMG

Register

Creating a Single Cell Analysis (screened) Project:

Go to the main project submission page and click the “Create Analysis Project for
Submission to IMG/MycoCosm/PhycoCosm” button, select “Single Cell Analysis
(screened) Project” from the drop-down menu, and proceed to the next step.
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Create Sequendng ProjeCt o AnaIYSis ProjECt _

» Create Sequencing Project in GOLD

~ Create AP for Submission to IMG/MycoCosm/PhycoCosm

Before proceeding:
o IMG only accepts FASTA (not Genbank formatted) files for analysis. See IMG FAQ.
* Metagenome-Assembled Genome (MAG) AP creation is no longer available. As an alternative... [more]
» There are two AP submission types: Primary and Re-analysis. [more]
o Your first two APs under each AP type needs to be approved before you can submit additional APs.

Select Analysis Project type to create:

(Single Cell Analysis (screened) Project v

Next Step >>

Choose the corresponding single cell SP from the drop-down menu.

Select Parent Project

You are creating a new Single Cell Analysis (screened) Project

Select one of your existing Sequencing Projects:
|Gp0514864 - Gammaproteobacteria bacterium 123 v|

OR
Search for a Public Sequencing Project (you will be asked to assign a study on
the next screen):

|

Fill in and submit the following form to create a Single Cell (screened) AP.




Create Analysis Project

You are creating a new Single Cell Analysis (screened) Project

Please fill in the form below to create a new Analysis Project.
The Sequencing Project for this AP is: Gammaproteobacteria bacterium 123
Analysis Project Type: Single Cell Analysis (screened)

Gammaproteobacteria bacterium 123
Suffix: Iscreened assembly ]

Analysis Project Name o

Study Test study for help doc examples

Analysis Project Description * | Assembly and annotation of screened draft ]
Analysis System * [ IMG v l

Pl Name [Supratim Mukherjee }
Pl Email [supramuk@gmail.com ]
Contamination Screening Method * iManuaI screening followed by automated decontamir]

Assembly Method * o [CLC v. 6.04, Newbler v. 2.3 ]

Number of tRNAs '

tRNA Software '

l
Completeness Strategy "' [Reference Based V|

Scaffold Count i 2 ]
Contig Count e i ]
Estimated Size i 4476920 ]
Sequencing Depth e I25)4 I

Genbank ID i ]

Assembly Accession l ]

Once an AP is created, you will see the following window:

Processing Complete

GOLD AP Ga0618792 created.
To submit your data set to IMG, you will need this Analysis Project ID: Ga0618792
Submit your data to IMG now.

Or start another Analysis Project.

Click the link to proceed to IMG for data submission.

If you are not ready to submit your data to IMG yet, you can return later and use
your AP for IMG submission. You will be redirected to the IMG submission page
when you click the “Annotate” button on the GOLD home page.
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JGIHOME LOGIN

TABASE

Biogeographical Metadata  Ecosystem Classification SRA Explorer  Statistics® Usage Policy Team Help News Downloads GOLD API
Welcome to the Genomes OnLine Database GOLD Release v.9

GOLD: Genomes Online Database, is a World Wide Web resource for comprehensive access to information regarding genome and
metagenome sequencing projects, and their associated metadata, around the world.

1. Register 2. Annotate

gl ——

= St
ﬂl}i!;:gﬂ

=

Annotate your microbial genome or
metagenome with IMG

Register your project information and
Metadata in the Genomes Online Database

3) Entering a Metagenome or a Metatranscriptome Sequencing
Project (SP) and associated Analysis Projects (APs).

From the GOLD home page, click the “Register” button to go to the landing page
for entering a Sequencing and/or an Analysis Project.

JGIHOME LOGIN

TABASE

Biogeographical Metadata  Ecosystem Classification  SRA Explorer  Statistics  Usage Policy’ Team Help News Downloads  GOLD APl
Welcome to the Genomes OnLine Database GOLD Release v.9
GOLD: Genomes Online Database, is a World Wide Web resource for comprehensive access to information regarding genome and
metagenome sequencing projects, and their associated metadata, around the world.

1. Register 2. Annotate

G@LD et
O]
—

Register your project information and
Metadata in the Genomes Online Database

Annotate your microbial genome or
metagenome with IMG

v

Create Sequencing Project or Analysis Project

» Create Sequencing Project in GOLD

» Create AP for Submission to IMG/MycoCosm/PhycoCosm

If your Sequencing Project is not yet in GOLD, you will start by clicking the “Create
Sequencing Project in GOLD” button to define a new Sequencing Project.
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Create Sequencing Project in GOLD

If you performed additional sequencing (either with a new seq. technology
or at a new seq. center) to your current project add the new information to
the corresponding field(s) of the existing project in GOLD and create a new
Analysis Project for it.

If submitting a newer assembly (for an existing project in GOLD) to IMG,
just create a new Analysis Project.

Is this a public NCBI genome/metagenome?
Yes O
No @

GOLD does not accept manually entered public NCBI genomes/metagenomes.
If you want to analyze a public genome/metagenome, follow detailed instructions
available here: Guidance on submitting public NCBI genomes and metagenomes
into GOLD and IMG. Otherwise, select the radio button ‘No’ to proceed.

Step 1: Study > Step 2: Select Project Type > Step 3: Biosample -> Step 4:
Sequencing Project > Step 5: Analysis Project

The first step to create a Sequencing Project is to define your Study. After
confirming that you are NOT entering a public NCBI genome/metagenome, you
will come to the page (see the screen below) where you will be able either to select
an existing study, under which you want to carry out this new sequencing project,
or to define a new study. When applicable, choose a matching study from the drop-
down menu.

1: Select/Create Study

—_————

Step 1: Select/Create Study

[Select a Study v

OR

Entering a new Study:
If your new sequencing project is pursued under a new study, click the “Create

Study” button to go to the Study entry form. Fill in at least all required fields (*) as
shown in the screenshot below. If there is an NCBI BioProject comprising multiple
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https://gold.jgi.doe.gov/resources/Guidance_import_NCBI_genomes_metagenomes_to_GOLD_IMG.pdf

other BioProjects, enter its Name, ID, and Accession into the corresponding NCBI
Umbrella BioProject fields. For example, PRINA28331 is an Umbrella BioProject
for Human Microbiome Project (HMP), and it contains about 3000 of the individual
BioProjects. If you do not have an umbrella BioProject, leave these fields blank.
Do not enter NCBI BioProject IDs or Accessions for individual BioProjects here at
the Study level. .

Note that GOLD follows a standardized, canonical naming system for microbiomes
which applies to a metagenome Study Name. More information on canonical
naming can be found here:

https://gold.jgi.doe.gov/resources/Standardized Metagenome Naming.pdf

Create Sequencing Project

1: Select/Create Study

L

Step 1: Select/Create Study

[Select a Study

OR

STUDY INFORMATION

Study Name *

Other Names

NCBI Umbrella Bioproject Name
NCBI Umbrella Bioproject Accession
PIName

Pl Email

Description *

Relevance

ECOSYSTEM CLASSIFICATION
Ecosystem *

Ecosystem Category *
Ecosystem Type

Ecosystem Subtype

Specific Ecosystem

Fill in the form with Study's metadata.

[Garden soil bacterial community from JGI lawn in Ca

l
l
l

[Supratim Mukherjee

[xxxxxx@lbl.gov

‘Metagenome sequencing of bacterial community fror

[Environmental v
| Add Relevance |

Environmental v

Terrestrial v
[Soil v
[Garden v

| Unclassified v

| Create New Study

Click the ‘Create New Study’ button and proceed to the next step, i.e., selecting
what kind of project you are about to create.
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Create Sequencing Project

1: Select/Create Study 2: Select Project Type

O @

Step 2: Select Project Type

Before proceeding:
« Review the Project Entry Help document.

Naming document. (PubMed ID: 36794865)
« Contact us with any questions, or if submitting more than 10 projects.

Select Sequencing Project type to create:
Biome ©
Organism O

Step 1: Selected/Created Study - Garden soil bacterial community from )Gl lawn in California, USA

« To avoid delay in processing your metagenomes/metatranscriptomes, read the Standardized Metagenome

Selecting an existing Biosample or entering a new Biosample:

If you have not created a Biosample for a specific sample yet, proceed to enter a
Biosample. If the sample is from a host-associated, a soil, an aquatic or any other
environment listed below, you have an option to select the appropriate package
and to get access to the form with additional metadata fields specific to the
respective environment. Otherwise, choose the Standard package to access the
default Biosample entry form. Note that like an Organism in GOLD represents one
specific strain, a Biosample in GOLD represents one specific environmental
sample. You cannot create a general Biosample for multiple environmental

samples even if they are from the same location.

Create Sequencing Project

1: Select/Create Study 2: Select Project Type 3: Select/Create Biosample

g 5 g

Step 2: Selected Project Type - Biome

Step 3: Select/Create Biosample

Select from your existing Biosamples:

Step 1: Selected/Created Study - Garden soil bacterial community from JGI lawn in California, USA

[Select an existing biosample...

OR
Create Biosample:
Select a package:

O standard
O Host-Associated Package
O Hydrocarbon Core Package
O Hydrocarbon FS Package
O Microbial Mat Package
O Plant Package
O sediment Package
O soil Package

O Wwater Package
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GOLD follows a standardized, canonical naming system for Biosamples. Detailed
information on canonical naming can be found here:
https://gold.jgi.doe.gov/resources/Standardized Metagenome Naming.pdf

Fill in at least all required fields in the Biosample entry form. For a metagenome,
the fields Habitat, Location, Ecosystem Classification, Sample Collection Site, and
few others are mandatory and must be populated to proceed to the next step. But
we encourage you to populate the other fields too if you have metadata for them.
See the example of the Biosample form for the Soil Package below. The fields
specific to the Soil package are highlighted in blue.

28


https://gold.jgi.doe.gov/resources/Standardized_Metagenome_Naming.pdf

Fill in the form with Biosample’s metadata

o Before proceeding, please read the GOLD St i M Naming D and follow the instructions
Biosample Name * i ] Garden soil bacterial communities from JGI lawn in Berkeley, California, USA — A1
L . It . ) f . P ]
Habitat Community Location Identifier]

[Garden soil bacterial communities from JGI lawn in Berkeley, California, USA - A1

Other Names i ] I

l
Habitat ' * ’Garden soil ]
Community o. lbacterial communities ]
Location © » lfrom JGI lawn in Berkeley, California ]
Identifier ' * (A1 |
NCBI Taxonomy ID * [ ] I410658 ]NCBI Metagenome Taxonomy.
NCBI Taxonomy Name soil metagenome
Biosample Description 0. [Soil sample collected after two days of rainfall from Is]

Ecosystem * Environmental ~
Ecosystem Category * Terrestrial v

Ecosystem Type *

Ecosystem Subtype I Garden V]
Specific Ecosystem Unclassified v
Sample Collection Site 0. Igarden soil l

Sample Collection Date * Month (mm): * Day (dd): Year (yyyy): *

Add collection time: Hour (hh): D Minute (mm): D

Sample Isolation Comments l l

Size Fraction i ] l l
Sample Isolation Country/Ocean * l USA v]

Sample Collection Method o l l

Sample Contact Name 0. ISupratim Mukherjee ]

Sample Contact Email ' * [xooooox@lblgov ]

Geographic Location 0. lUSAZ Berkeley l
Lat/Long Lookup Get Coords
Latitude ' * [37'877 l
Longitude * [-122.2456 || Reset Map |
o Reno_
+ Chico fe
a0
—_ Carson
Sacramento o
santa L ™
Oal 9Stockton i .
R0~ JC N
Sa?g?se California N

Fresno
Salinas o

Visalia
Leaflet | Map data © OpenStreetMap contributors, CC-BY-SA, Imagery ©

OpenStreetMap
LatLong Information *
Elevation (129 | Meters. to| ]Meters.[ Add Elevation Range ]
Depth [ | Meters. to] | Meters. | Add Depth Range |
Subsurface Depth ( | Meters. to| | Meters.| Add Subsurface Depth Range
Sample Collection Temperature l55 l Celsius. to [ l Celsius.

[ Add Sample Collection Temperature Range ]

Salinity (MIGS-6.3) Select from below... v

Pressure l ]

PH 8 | tof ][ Add pH Range |

Salinity Concentration l l

[ Create New Biosample J
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Mean Annual Precipitation l 25

Mean Seasonal Precipitation [

Mean Seasonal Temperature [

I
I
Mean Annual Temperature l 15.4 I
I
I

Link Climate Info [

Crop Rotation

Current Land Use

Shrub Land v|

Perrenial Grass and Coastal Shrubs

Current Vegetation

Current Vegetation Method

Flooding

Extreme Event

Previous Land Use

|
l
|
l
Fire [
l
|
l
|

Previous Land Use Method

Drainage Class

Moderately Well |

l
FAO Class [Select from below... V|
Horizon | A Horizon v
Horizon Method l |
Link Class Info { |
Local Class l |
Local Class Method [ |
Profile Position [Backslope v
Sieving [ |
Slope Aspect W-sw I
Slope Gradient 32 l

After defining a Biosample, proceed to the next step, i.e., creating a metagenome
SP.

Entering a Metagenome Sequencing Project:

To define a new metagenome Sequencing Project, choose DNA as a nucleic acid
and Metagenome as a sequencing strategy type and populate at least all required
fields (*) such as Sequencing Center, Project Description, Sequencing Strategy
Type, Sequencing Technology, etc. as shown in the screenshot below. After that,
click the “Create New Sequencing Project” button.
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Project Name * Garden soil bacterial communities from JGI lawn in Cz]

Other Names o
NCBI BioProject Name

NCBI BioProject Accession i

NCBI BioSample Accession i

l
l
l
l
NCBI Locus Tag "' [
l
l
l
[

l
I
l
I
I
l
I
l

Contamination Screening Input

Pl Name

Pl Email

Project Comments

Sequancing Center University of California, Berkeley x

Collaborating Institute DOE Joint Genome Institute (JGI) x

Funding Agency ’ |

Project Description * o [Metagenome sequencing of garden soil bacterium fronl

Specimen Biome v

Nucleic Acid * [ DNA v I

Sequencing Strategy Type * [Metagenome v | Select "Metagenome" for shotgun sequencing
using DNA as starting material.

Sequencing Strategy Subtype [Select from below... V| Click for Subtype information...

Sequencing Status * [ Complete v I

Sequencing Quality (MIGS-31) * [Level 1: Standard Draft V|

Elnishing]Goal 'Select from below... v

Select from below... V|

DNA Amplification Method [Select from below... VI

Sorting Technology Select from below... v

Single Cell Lysis Protocol '

S DR L DL A Select from below... v

Sequencing Comments o

DNA Amplification Kit "'
s ing Technology (MIGS-29) *

4 =

Illumina HiSeq 1000 v

Library Layout Select from below... V|

Library Screening Method i

Number Of Reads "'

Read Size o

Vector i
GC Percent

[
l
[
[
[
(
Library Method ' [ |
[
[
l
[
[
[

[ Create New Sequencing Project ]
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In addition to the traditional metagenome sequencing project, there are two
subtypes of the metagenome SPs that are available to a user to choose from,
based on how the sample was isolated. These two subtypes are:

i)

Metagenome - Cell Enrichment: A draft metagenome assembly
derived from a cell enrichment (> 1 cell) sample. A cell enrichment is
generally obtained by physical separation of a biologically relevant unit,
such as microcolonies. Due to the low biomass for cell enrichments, the
extracted DNA is typically amplified using whole-genome amplification
prior to sequencing.

Metagenome - Single Particle Sort: A draft genome or metagenome
assembly derived from a single particle isolated via flow cytometry. A
single particle sort can consist of a single cell or an aggregate of multiple
cells, not necessarily of the same phylogenetic background. The
extracted DNA is amplified using whole-genome amplification prior to
sequencing. No amplicon-based 16S rRNA gene information is available
for single particle sorts.

Entering a Metatranscriptome Sequencing Project:

To create a metatranscriptome SP, follow the same steps described above for a
metagenome SP, but choose RNA as a nucleic acid and Metatranscriptome as a
sequencing strategy type.

Entering a Metagenome Analysis Project:

Go to the main project submission page and click the “Create AP for Submission
to IMG/MycoCosm/PhycoCosm” button. Select “Metagenome Analysis Project” (or
one of the subtypes if applicable: Metagenome — Cell Enrichment or Metagenome
- Single Particle Sort Analysis Project) from the drop-down menu and click the
“‘Next Step” button.
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i et e *

» Create Sequencing Project in GOLD

Create AP for Submission to IMG/MycoCosm/PhycoCosm

Before proceeding:
« IMG only accepts FASTA (not Genbank formatted) files for analysis. See IMG FAQ.
+ Metagenome-Assembled Genome (MAG) AP creation is no longer available. As an alternative...
[more]
« There are two AP submission types: Primary and Re-analysis. [more]
« Your first two APs under each AP type needs to be approved before you can submit additional
APs.

Select Analysis Project type to create:

| Metagenome Analysis Project v

\i Next Step >> )

Like in the case of the Genome Analysis Projects described earlier, you can create
a Metagenome Analysis Project for your own Sequencing Project that you have
created earlier or for a public Sequencing Project in GOLD if you have
reassembled the associated public sequences and want to re-annotate
them.

To create an AP for your own metagenome sequencing project, select a
corresponding SP from the drop-down menu, as shown in the screenshot below
and proceed to the next step.

| Select Parent Project |

You are creating a new Metagenome Analysis Project

(Note: A metagenome Analysis Project can only accept sequence data from shotgun
sequencing using DNA as starting material. Do not pass on 16s surveys or iTags as
metagenomes. Violators may risk losing GOLD/IMG privileges to submit further data
sets.)

Select one of your existing Sequencing Projects:
[Gp0326317 - Garden soil bacterial communities from JGI lawn in California, USA - Al

OR
Search for a Public Sequencing Project (you will be asked to assign a study on
the next screen):

\ Next Step >>

Note: If you still need to create a new sequencing project for your submission please
click below to create a new sequencing project.

[Md New Sequencing ProjectJ

Choose the corresponding metagenome SP from the drop-down menu.
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Fill in at least the required fields of the Analysis Project form to define an AP for
your metagenome.

Create Analysis Project

You are creating a new Metagenome Analysis Project

Please fill in the form below to create a new Analysis Project.
The Sequencing Project for this AP is: Garden soil bacterial communities from JGI lawn in California, USA - A1
Analysis Project Type: Metagenome Analysis

Garden soil bacterial communities from JGI lawn in California, USA - A1
Suffix: I first draft I

Analysis Project Name o

Study Old Garden soil bacterial community from JGI lawn in California, USA
Analysis Project Description * [Assembly and annotation of garden soil bacterial conl
Analysis System * IMG v l

[
Pl Name | Supratim Mukherjee |
Pl Email |

XXXXXXX@Ibl.gov |

Assembly Method * O [Velvet v.2.3 l
Scaffold Count ' [525 l
Contig Count i [ I
Estimated Size [ 22259846 l
Sequencing Depth i [ 100x I

Genbank ID [ l

Assembly Accession [ I

Once you submit the above form, a Metagenome Analysis Project will be created
and you will see the following message:

[ Processing Complete

GOLD AP Ga0618796 created.
To submit your data set to IMG, you will need this Analysis Project ID: Ga0618796

Submit your data to IMG now.

Or start another Analysis Project.

Click the link to proceed to IMG for data submission.
If you are not ready to submit your data to IMG yet, you can return later and use

your AP for IMG submission. You will be redirected to the IMG submission page
when you click the “Annotate” button on the GOLD home page.
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JGIHOME LOGIN

ABASE

Biogeographical Metadata  Ecosystem Classification SRA Explorer  Statistics® Usage Policy Team Help News Downloads GOLD API

Welcome to the Genomes OnLine Database GOLD Release v.9
GOLD: Genomes Online Database, is a World Wide Web resource for comprehensive access to information regarding genome and
metagenome sequencing projects, and their associated metadata, around the world.

1. Register 2. Annotate
GE8LD E-
[ Cone oo ot | —
|
Register your project information and Annotate your microbial genome or
Metadata in the Genomes Online Database metagenome with IMG
Register Annotate )

Steps for creating a Metagenome AP for a public metagenome SP are the same
as for a public isolate genome SP. See the corresponding section above.

Entering a Metatranscriptome Analysis Project:

The steps for creating a Metatranscriptome AP after you select “Metatranscriptome
Analysis Project” from the drop-down menu on the submission page are the same
as for creating a Metagenome AP.

Note that Metatranscriptome APs can be created only for your own
Metatranscriptome SPs.

5) Creating a Combined Assembly Analysis Project (AP) in GOLD.

When you combine sequence data from more than one sequencing project and
generate a single assembly, it is called combined assembly. Currently we support
five types of combined assemblies. They can be between sequencing projects of
the same type or between sequencing projects of different types:

1) Metagenomic projects

2) Metagenomic project with Single-Cells

3) Metatranscriptome projects

4) Single-Cell projects

5) Sequencing Projects from a single Organism

5a) Creating a metagenomic Combined Assembly Analysis
Project (AP).

Use case: Say, you have two or more metagenome SPs in GOLD, and you are
hoping to get a better assembly by doing a combined assembly of the sequences
you have obtained under more than one SP. Then you need to define a Combined
Assembly AP in GOLD.

First, select the “Combined Assembly” AP type from the drop-down menu and
proceed to the next step.
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Create Sequencing Project or Analysis Project _

» Create Sequencing Project in GOLD

Create AP for Submission to IMG/MycoCosm/PhycoCosm

Before proceeding:
» IMG only accepts FASTA (not Genbank formatted) files for analysis. See IMG FAQ.
» Metagenome-Assembled Genome (MAG) AP creation is no longer available. As an alternative...
[more]
o There are two AP submission types: Primary and Re-analysis. [more]
» Your first two APs under each AP type needs to be approved before you can submit additional APs.

Select Analysis Project type to create:

Combined Assembly Project M

\: Next Step >> \

The “Metagenomic projects” radio button is preselected by default.

Using the search box, choose two or more metagenome SPs representing the
sequences that you have used for your combined assembly as shown below.

H Combined Assembly —

1. Please select the type of Sequencing Projects that make up the Combined Assembly.

Metagenomic projects: @ (default)
Metagenomic project with Single-Cells:
Metatranscriptome projects:

Single-Cell projects:

Sequencing projects from a single organism:

2. Please select the Sequencing Projects that make up the Combined Assembly.

Search for your sequencing projects and add them into the list below:

Gp0326317 - Garden soil bacterial communities from
JGI lawn in California, USA - A1

Gp0326573 - Garden soil bacterial ities from
JGI lawn in California, USA - A2

]» Next >> |

Fill in at least the required fields of the Combined Assembly Analysis Project form.
If the SPs you have used in your combined assembly came from two different
studies, at this point, you will be able to select the study under which you want your
new AP to appear.
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Create Analysis Project

You are creating a new Combined Assembly Project

Please fill in the form below to create a new Analysis Project.
The Sequencing Project for this AP is: Combined Assembly With Multiple SPs
Analysis Project Type: C i A bl
ANALYSIS PROJECT INFORMATION

Combined Assembly of
Suffix: | Garden soil bacterial community from JGI Iawn‘

Analysis Project Name

Study Old Garden soil bacterial community from JGI lawn in California, USA

Analysis Project Description * Combined assembly of different types of soil from JG|

Analysis System * IMG hd ‘

Pl Name Supratim Mukherjee ‘

Pl Email Xxxxxx@Ibl.gov ‘

ANALYSIS PROJECT METADATA

Assembly Method * Metavelvet v. 1.0

Contig Count

I
Scaffold Count ‘
I
\

Estimated Size

PROJECT EXTERNAL REFERENCES
Genbank ID ‘

Assembly Accession ‘

Submit |

Once you create a Combined Assembly AP, you can proceed to IMG for submitting
your data, or you can leave and return later to submit your dataset (see page 34-
35 for more details).

Combined Assembly APs for metatranscriptome projects can be created in a
similar manner.

5b) Creating a metagenomic and single cell Combined Assembly
Analysis Project (AP).

Use case: Say you had sequenced a single cell genome, but it was a partial
assembly. Then you found hits in one of your metagenomes to this single cell
genome and decided to take advantage of the available metagenome sequence
to get a better assembly for your single cell genome. In this case, you need to
define a Combined Assembly AP that includes a metagenome and a single cell
SP.

First, select the “Combined Assembly” AP type from the drop-down menu and
proceed to the next step.

Select the “Metagenomic projects with Single-Cells” radio button as shown in the
screen below.

Using the search boxes (separate boxes for metagenome SPs and single cells
SPs are provided), choose one or more metagenome and single cell genome
sequencing projects that you have used for your combined assembly. Once you
select all component SPs of your combined assembly, proceed to the next step.
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1. Please select the type of Sequencing Projects that make up the Combined Assembly.

Metagenomic projects: O (default)
Metagenomic project with Single-Cells: ©
Metatranscriptome projects: O

Single-Cell projects: O

Sequencing projects from a single organism: O

2. Please select the Metagenome Sequencing Project and Single Cell project for the
Combined Assembly.

A. Please search for your Metagenome sequencing project:

Gp0704594 - Garden soil bacterial communities from
JGI lawn in California, USA - A1

B. Please search for your Single-Cell sequencing projects:

Gp0514864 - Gammaproteobacteria bacterium 123 x

Fill in at least the required fields. If the SPs you have used in your combined
assembly are from two different studies, at this point, you will be able to select the
study under which you want your new AP to appear.

Create Analysis Project

You are creating a new Combined Assembly Project

Please fill in the form below to create a new Analysis Project.
The Sequencing Project for this AP is: Combined Assembly With Multiple SPs
Analysis Project Type: Combined Assembly

Analysis Project Name o Combined Assembly of

Suffix: [Gammaproteobacteria bacterium 123 (Metager]
Study * [Test study for help doc examples (Gs0128764)
Analysis Project Description * [Analysis of Gammaproteobacteria bacterium single cl
Analysis System * [ IMG v ]
Pl Name [Supratim Mukherjee l
Pl Email

[xxxxx@lbl.gov I

Assembly Method * ' iNeWbler v.2.1

Scaffold Count " i

Contig Count i i

Estimated Size i

Genbank ID i l

Assembly Accession l l
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Once you create a Combined Assembly AP, proceed to IMG for submitting your
data or return later and submit your dataset, using the “Annotate” button on the
GOLD home page (see page 34-35 for more details).

5¢) Creating a single cell Combined Assembly Analysis Project
(AP).

Use case: Say you had sequenced several single cell genomes and assembled
them separately. But each one of those ended up being a partial assembly. Then
you found that two of the single cell genomes you had sequenced appeared to be
very similar. So, you decided to do a combined assembly, using sequence data
from two individual single cell genome projects. In this case, you need to define a
Combined Assembly AP that includes both single cell SPs.

First, select the “Combined Assembly” AP type from the drop-down menu and
proceed to the next step.

Select the “Single-Cell projects” radio button as shown in the screen below.

Combined Assembly

1. Please select the type of Sequencing Projects that make up the Combined
Assembly.

Metagenomic projects: O (default)
Metagenomic project with Single-Cells: O
Metatranscriptome projects: O

Single-Cell projects: @

Sequencing projects from a single organism: O

2. Please select the Sequencing Projects that make up the Combined
Assembly.

Search for your sequencing projects and add them into the list below:

Gp0514864 - Gammaproteobacteria bacterium 123 X
Gp0514870 - Gammaproteobacteria bacterium 456 x

Next >> \

Using the search box, choose two or more single cell genome sequencing projects
that you have used for your combined assembly as shown above. Once you
selecte all component SPs of your combined assembly, proceed to the next step.
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Create Analysis Project
You are creating a new Combined Assembly Project

Please fill in the form below to create a new Analysis Project.
The Sequencing Project for this AP is: Combined Assembly With Multiple SPs
Analysis Project Type: Combined Assembly
ANALYSIS PROJECT INFORMATION
Analysis Project Name Combined Assembly of
Suffix: ‘Gammapmteobacleria single cells

Study Test study for help doc examples

Analysis Project Description * | Combined assembly of two single cell projects for im|
Single Cell Assembly Type W
Contamination Screening Method * [Manual screening followed byl
Analysis System * IMG v
Pl Name | Supratim Mukherjee
Pl Email [ XXxxxx@Ibl.gov
ANALYSIS PROJECT METADATA
Assembly Method * [CLC V. 6.04, Newbler v. 2.3
Scaffold Count I
Contig Count ‘
Estimated Size [
PROJECT EXTERNAL REFERENCES
Genbank ID l
Assembly Accession I
| Submit

Fill in at least the required fields. If the SPs you have used in your combined
assembly are from two different studies, at this point, you will be able to select the
study under which you want your new AP to appear.

Once you create a Combined Assembly AP, proceed to IMG for submitting your
data or return later and submit your dataset, using the “Annotate” button on the
GOLD home page (see page 34-35 for more details).

5d) Creating a Combined Assembly Analysis Project (AP) with
sequencing projects from a single organism.

Use case: Say you had sequenced a single organism in your lab but did not get a
good assembly. You then came across a public SP for the same organism in
GOLD. You now have the option to combine sequence data from your SP and the
data from the public sequencing project of the same Organism to create a
combined assembly AP. This option is only available if there are two or more
Sequencing Projects for exactly the same strain of a single GOLD Organism. To
define such a combined assembly AP, select the “Combined Assembly” AP type
from the drop-down menu and proceed to the next step.
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Combined Assembly

1. Please select the type of Sequencing Projects that make up the Combined Assembly.

Metagenomic projects: (default)
Metagenomic project with Single-Cells:
Metatranscriptome projects:

Single-Cell projects:

Sequencing projects from a single organism: ©

2. Please select the Organism for Sequencing Projects that you plan to use in the Combined
Assembly.

Search for an organism by entering genus or species:
126677 - Escherichia coli DSM 30083 x

Select the related projects that you want to combine

(Use the windows/mac command keys to select multiple projects from the drop-down):
Gp0139467 - Escherichia coli DSM 30083
Gp0139389 - Escherichia coli DSM 30083 - v2

Select the “Sequencing projects from a single organism” radio button as shown in
the image above. In the search bar, enter the name of the organism for which you
want to create the combined assembly AP. Note that only those Organisms that
have two or more Sequencing Projects in your GOLD user account will show up.
Once you select the Organism of your choice, the Sequencing Projects associated
with it will be displayed in the box below. Select the Sequencing Projects that you
want to include in your Combined Assembly AP and proceed to the next step.
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Create Analysis Project

You are creating a new Combined Assembly Project

Please fill in the form below to create a new Analysis Project.
The Sequencing Project for this AP is: C i With Multiple SPs
Analysis Project Type: Combined Assembly
ANALYSIS PROJECT INFORMATION

N q Combined Assembly of
Analysis Project Name — "
Suffix: | Escherichia coli DSM 30083 ]
Study * |Comparative analysis of two human pathogenic bacteria (Gs0118715) v |
Analysis Project Description * |COmbined assembly of Escherichia coli DSM 30083 |
Analysis System * IMG v
Pl Name

[Supratim Mukherjee ‘

Pl Email | xxxxxx@Ibl.gov ‘

ANALYSIS PROJECT METADATA

Assembly Method * [Newbler v.2.3

Scaffold Count ‘

Contig Count l

Estimated Size ‘

PROJECT EXTERNAL REFERENCES
Genbank ID l ‘

Assembly Accession [ ‘

Submit |

Fill in at least the required fields as shown above. If the SPs you have used in the
combined assembly are from two different Studies, at this point, you will be able to
select the study under which you want your new AP to appear. Click the “Submit”
button to create a new AP. Once you create a Combined Assembly AP, proceed
to IMG for submitting data or return later and submit your dataset, using the
“‘Annotate” button on the GOLD home page (see page 34-35 for more details).
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